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Section 1
Basics of ICT
By the end of this section you should be able to:
Understand the term ICT
Recognise the differences between hardware and software
Use different input, output and storage devices
Know how to connect peripheral devices
Appreciate the factors affecting device performance
Spot important health and safety issues when using ICT
Select the right software program(s) to complete a task
Work accurately, safely and securely

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then,
if applicable, perform the numbered steps of the Manoeuvres. Complete the
Revision exercise(s) at the end of the section to test your knowledge.
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Driving Lesson 1 - ICT Concepts
Park and Read
The term ICT stands for Information and Communication Technology.
Pretty much any device or computer program that creates, stores or uses digital
information can be considered an ICT system, including:
•

Hardware such as desktop computers, laptops, netbooks, tablets and
games consoles.

•

Software programs such as web browsers, word processors,
spreadsheets, databases, e-mail systems, graphics programs and
games.

•

Internet technologies such as Google, Twitter, Facebook and Instagram.

•

Mobile devices such as smart phones, GPS systems, media players,
digital cameras, iPads and iPods.

•

Peripheral items such as printers, scanners, keyboards and mice.

You will learn more about hardware, software, peripheral devices and Internet
technologies later in this guide.
Computing and mobile technologies have completely transformed how people
live their lives – at home, in education and at work. They have changed how
people communicate with each other, how they store and access information,
how they work, and how they spend their spare time. In fact, ICT systems allow
people to better explore ideas, handle lots of information, find answers to
questions, solve problems, and become more productive in their personal and
professional lives.
If you want to be an active member of your own society and succeed in
education and a future career, your ability to fully understand and use ICT
technology safely and effectively will be an essential skill.
ICT systems are used in more places than you may realise: car engines,
vending machines, home heating systems. Even some “smart” refrigerators
have built-in Internet connections that automatically reorder groceries.

Manoeuvres
1.

Does the term ICT just refer to computers such as desktop, laptop and
tablet PCs?

2.

Consider all of the ICT devices you own or the Internet services you use.
You will be surprised how many different types of technology you interact
with on a daily basis.

Windows 10
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Driving Lesson 2 - Using ICT Safely
Park and Read
Before you start working with equipment of any kind, you first need to know
how to use it safely and responsibly. ICT devices are no different, and whether
you use them at home, in education, or as part of your job, you are required by
law to take reasonable care of your own safety and the safety of others.

In both education and work, the people in charge of you are legally required to
make sure you are well-protected and well-trained. For ICT users, this means
providing you with equipment that is safe, secure and comfortable to use.
Modern ICT systems present a number of health and safety hazards that you
must be aware of. Whenever you use an electronic device of any sort, no
matter where it is, you should always watch out for the following hazards:
•

Electrical injuries and fires from damaged wires or incorrect connections

•

Electrical injuries and fires from overloaded power sockets (too many
plugs connected to one outlet)

•

Injuries and fires caused by badly stored materials (paper and other
items piled up and around equipment)

•

Breakdowns and breathing problems due to poor ventilation (many ICT
devices need to be kept cool and some types of printer can produce
unhealthy fumes)

•

Trips due to trailing cables or problems accessing your work area

•

Injuries caused by incorrect equipment handling (heavy or large devices)

When you use ICT on the move you need to be even more alert for dangers.
For example, watch out for any hazards that could trip you up or cause a
serious fall, and never use a mobile device (such as a telephone or tablet
computer) when driving or operating dangerous machinery.
Try not to eat or drink when using an ICT device. Food and liquids can easily
be dropped or spilled which can damage equipment or cause electrical injuries.

© CiA Training Ltd 2016
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Driving Lesson 2 - Continued
Depending on your age, level of ability and where you study or work, there may
also be other health and safety hazards to be aware of. For example, you may
need to wear protective clothing and keep out of areas where dangerous
materials or machinery are stored. Watch for warning signs and follow any
health and safety information given to you.
Always tell someone in charge about any health and safety concerns you have.
If you do hurt yourself or damage a piece of equipment, you must report it.

Manoeuvres
1.

Look around you. Check that there are no cables lying across the floor
that you or somebody else could trip over.

2.

Check that there are no cables hanging down behind your desk that could
tangle with your feet as you work. This includes power cables and Internet
connection wires.

Take care when adjusting cables. Always make sure your computer equipment
is turned off and unplugged from the wall before you start.
3.

Look out for and immediately replace worn or frayed cables. Never
examine a damaged wire or device until it has been turned off and
unplugged.

4.

Check for sockets or power extensions that have too many plugs in them.
Overloaded electrical sockets can easily cause fires or injury.

5.

Remove any unnecessary clutter from your work environment and avoid
storing items where they could fall and cause injury or damage.

6.

Finally, check your surroundings for any other dangers, obstructions, trip
hazards (e.g. wires, boxes, bins and bags), fire hazards, and so on.

In every building in which you study or work, you should always know where
the emergency exits and fire extinguishers are located.
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Driving Lesson 3 - Your Workspace
Park and Read
If you sit at a computer or use ICT equipment for long periods of time, it can
start to get uncomfortable and – in severe cases – cause injury. To stay safe
and well you need to learn how to avoid these problems before they start.
Remember: prevention is always better than cure!
When using ICT equipment always remember the following simple precautions:
•

Take regular breaks away from all of your ICT devices (one or two
minutes every hour).

•

Look away from screens regularly (and remember to blink often).

•

Vary your work activities so that you do not perform the same task for
too long.

•

Do not sit with a poor posture or hold heavy ICT devices for long periods
of time.

•

Use simple stretching exercises to relax your muscles and stay active.

If you use a desktop or laptop computer for any length of time, it is also
important that you set up your work space correctly. The following advice will
help:
•

Position your computer monitor directly in front of you with the top of the
screen at roughly the same height as your eyes.

•

Adjust the position of your chair so that you can sit upright at your desk
about one arm’s length away from your screen (50 to 80 centimetres is
recommended).
50 - 80cm

•

Adjust the screen to reduce glare and reflections from lights or windows.

© CiA Training Ltd 2016

12

Windows 10

ECDL

Section 1 Basics of ICT

Driving Lesson 3 - Continued
•

Set up your chair so that it fully supports your back and make sure your
feet rest firmly on the floor. Foot and wrist rests can be used to help.

•

Place your keyboard and mouse directly in front of you and do not
stretch to reach them. Your forearms and hands should always remain
parallel with the floor.

Manoeuvres
1.

Adjust your chair so that your back is straight and your hands are placed
comfortably over the mouse and keyboard. Your feet should lie flat on the
ground.

2.

Check that the computer screen you are using is positioned at a
comfortable height and angle so that you can see it without straining.

3.

Make sure there is no glare or reflection from other light sources (i.e.
windows or ceiling lights).

4.

Adjust the position of the screen, keyboard and mouse so that you are
comfortable operating the computer.
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Driving Lesson 4 - Computing Hardware
Park and Read
ICT devices come in a variety of forms: digital cameras, smart phones, MP3
players, and desktop, laptop and tablet computers. All of these devices are
known as hardware, which is a term that refers to any piece of physical
technology you can touch.
Desktop PC
including separate
monitor, keyboard
and mouse

Laptop

Mobile
Phone

Tablet

Two of the most popular types of Personal Computing (PC) device are the
desktop computer and the laptop computer. Smaller, cheaper versions of
laptops known as netbooks are also quite common, but these simply allow
users to connect to the Internet and often suffer from poor performance.
Gaining in popularity are tablet computers which are smaller again and
usually feature a touch screen. Of course, one of the most popular ICT devices
in the world today is the mobile phone.
Hardware

Advantages

Disadvantages

Desktop PC

High performance; easy to
upgrade and repair; lots of
peripherals to attach; large
monitor sizes

Large and can’t be moved
easily; requires a lot of
dedicated desk space

Laptop PC

High performance; easy to
move and use “on the go”;
wireless network access

Usually more expensive
than a desktop; higher
chance of being lost, stolen
or damaged; harder to
upgrade and repair; short
battery life; often causes
poor posture

Netbook

Cheap, small, light and
portable; wireless network
access

Chance of being lost,
stolen or damaged; low
performance; hard to
upgrade and repair; short
battery life; causes poor
posture
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14

Windows 10

ECDL

Section 1 Basics of ICT

Driving Lesson 4 - Continued
Tablet

Very light and portable;
easy to use; wireless
network access

Slower than a laptop;
almost impossible to
upgrade; small screen and
lack of features reduce
productivity; short battery
life

Mobile Phone

Very light and portable;
smart phones have lots of
communication features;
3G and 4G network access

Easy to lose or break; small
screen size limits
usefulness; very short
battery life

Nearly all ICT computing devices share two important internal hardware
components that work closely together: a processor and memory. The
processor is the “brains” of a device and performs all of the basic calculations
and functions that make it work. The memory is used to temporarily store
programs of instructions and “active” data as they are being worked on by the
processor.
A processor is also known as a CPU (Central Processing Unit). It is a small
microchip that can get very hot when in use and needs to be kept cool.
A device’s memory is often referred to as RAM (Random Access Memory).
Unlike other ICT storage devices that take a small amount of time to access
and store information, RAM memory works very quickly. This allows the CPU to
read instructions and work with data at high speed.
Many ICT devices have built-in “boot” instructions stored on special Read Only
Memory (ROM) chips. These are used to start the device and begin loading its
basic operating system software.
To be saved long-term, data needs to be recorded on a storage device such as
an internal hard disk drive or an external USB memory stick. You will learn
more about storage devices later in this section.
It is important to realise that RAM is not the same as storage. A device’s
memory temporarily holds data as the processor works on it; a storage device
stores it permanently (or at least until it is manually deleted).
Finally, most professional computing devices feature one or more optical disc
drives for reading from and writing to CD and DVD discs. These drives typically
eject a tray into which a disc is placed; when the tray is closed the device will
automatically recognise the new media and open it.
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Section 2
Getting Started
By the end of this section you should be able to:
Start, restart and close down a device
Log on and log off Windows
Recognise and use the Desktop
Open, resize, reposition and close windows
Identify parts of a window
Understand the Start Menu and Taskbar
Start and close programs
Find help

Work through the Driving Lessons in this section to gain an understanding of
the above features.
For each Driving Lesson, read all of the Park and Read instructions and then
perform the numbered steps of the Manoeuvres. Complete the Revision
exercise(s) at the end of the section to test your knowledge.
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Driving Lesson 12 - Starting your Computer
Park and Read
Although there are many different types of ICT hardware available, this guide
focuses on the use of traditional computing devices such as desktop, laptop
and tablet computers. To start such a device, it must be turned on using its
main on/off power button.
Before switching a computer on, briefly check for any lights – usually found on
the front of the device – that show it is already activated. When left for a period
of time, an ICT device can go into a dormant power-saving mode. Either move
the mouse or press a key on the keyboard to “wake it up”.

Manoeuvres
1.

Locate your computer’s power button. This is usually marked with the
following symbol:

2.

If your computer is currently switched off (i.e. there are no lights on the
front, the screen is blank and interacting with the mouse/keyboard has no
effect) press the power button now. The computer starts.

3.

If you are using a separate monitor, this also needs to be turned on. If
there are no lights on the front of it and the screen is blank, locate and
press the power button now.

Computing devices go through a short start-up (or “boot”) process that detects
all connected hardware and loads the operating system.

This guide assumes you are using Windows 10.
4.

After a moment the Windows 10 operating system is loaded. Please
continue to the next lesson.

Windows 10
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Driving Lesson 13 - Logging On
Park and Read
Windows allows more than one person to securely “sign in” and use a
computer. Each person has their own settings and private storage folders in
which to keep and organise their files.

To access your own files and folders and start using the computer, you first
need to log on to Windows. This involves entering a username and a
password that is known only by you.
Together, a username and password prove a person’s identity and right to
access files and shared devices. If a device is lost, stolen or left unattended for
a time, passwords will act as your own personal entry codes and stop
unauthorised use.
If you don’t know your own username or password, ask the person in charge of
your computer or network for help. If you log on using a Microsoft account, you
can reset your password online at www.live.com.

Manoeuvres
1.

When Windows starts, a Lock Screen is displayed. This shows the time
and date and appears when nobody is logged on (or the computer has
been locked). Click the mouse or press a key to log on.

If your computer is connected to a network you may be prompted to log-on by
pressing <Ctrl Alt Del>. You will need to press and hold the <Ctrl>, <Alt> and
<Delete> keys down together to do this.
2.

You will now be invited to identify yourself. Select your username from the
list of registered users (if it is not selected already).

If your username does not appear, click Other user and then type your
username in the Username box.
3.

Next, type your password in the Password box and press <Enter>.

4.

After a moment the Windows Desktop is displayed. Please continue to
the next lesson.
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Driving Lesson 14 - The Windows Desktop
Park and Read
The Desktop is where you will do all of your work in Windows. Similar to the
top of a real desk, you can place things on it such as files and folders. All of the
programs you start will also appear here.

Desktop

Icons

Taskbar
Search Box

Notification
Area

Start Button

Windows can be customised according to your own preferences and that of the
organisation which licenses it. Nearly every aspect of its appearance can be
changed. For this reason, the screenshots shown in this guide may not exactly
match that of your computer. The basic layout and functionality, however,
should be the same.
The Icons that appear on the Desktop represent a small selection of the
programs, folders and files stored on the computer. As you will learn later in this
guide, they are small pictures that you “double click” to start or open. Most
icons are accompanied by a short label to help you identify them.

Along the bottom of the Desktop is an area known as the Taskbar. This is
used to start, access and manage running programs and usually remains on
screen at all times. The Start button – on the left of the Taskbar – is used to
start nearly all programs and Windows features.
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Driving Lesson 14 - Continued
More than one program can run at the same time (this is known as multitasking). As each program is started, it becomes active and a button for it
appears on the Taskbar. If the same program is opened many times, Windows
will group buttons together to save space.
The background of an active program button is lighter than inactive ones and
appears with a small coloured bar at the bottom.
Start Button

Active running program

Search Box

Inactive, “pinned” shortcut

Active “grouped” program

You will start a number of programs later in this section. When you do, notice
how their buttons appear on the Taskbar.
The Notification Area on the right of the Taskbar displays the date and time.
Short messages, program updates and important alerts from Windows may
also appear here. These are called notifications.

Notification

If you miss a notification, you will find it in the Action Centre panel. This is
shown when you click the notifications icon,
, in the Notification Area.
Some programs also add small icons in the Notification Area to provide status
updates and allow you to quickly access settings (which you can do by “doubleclicking” them – quickly clicking the left mouse button twice).
The Search box on the Taskbar can be used to find files, folders and programs
on your computer. It can also be used to search the web and access Cortana,
a virtual “personal assistant”. When set up, Cortana can be used to search for
information or interact with apps by simply speaking to it.

Manoeuvres
1.

Examine your Desktop and locate the Recycle Bin, Taskbar, Start
button, Search box and Notification Area.
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Driving Lesson 15 - The Start Menu
Park and Read
At the left of the Taskbar is the Start button. Clicking the Start button opens
the Start Menu which can be used to “run” any desktop program or app
installed on your computer. The Start Menu can also be used to access private
files and folders, find help and support, and control your computer’s settings.

Manoeuvres
1.

From the Windows Desktop, click the Start button. The Start Menu
appears.

Most Used
Programs List
Tile

Program buttons

All apps

Start Menu colours and designs may change depending on your device and
setup options. Due to this, it may not appear exactly as shown.
2.

Take a look at the Start Menu. A list of your Most used desktop
programs and apps appears on the left.
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Driving Lesson 15 - Continued
3.

Notice the buttons in the bottom left corner of the Start Menu. These
provide fast access to your private files, folders and computer settings.
You can also turn off or restart your computer using the power options.

4.

On the right of the Start Menu is a grid of coloured squares known as
tiles. Each tile represents a program or app that can be clicked to start.

Start Menu and Taskbar buttons only need to be clicked once to start or open
them.
5.

Without clicking, try and locate the following buttons and tiles. Some of
these will be used later in this guide.
File Explorer

opens a window that allows you to explore
the files and folders stored on your
computer.

Settings

allows you to adjust your computer’s basic
settings

Power

can be used to turn off or restart your
computer.

Mail

starts a useful e-mail program

Calendar

starts a program that allows you to view and
manage upcoming appointments/events

Microsoft Edge

starts a useful web browsing program

By default, you will also find buttons for the popular Microsoft Edge and File
Explorer on the Taskbar.
The Live Tile feature in Windows 10 shows useful information on tiles without
needing to open the full program. For example, Mail will show unread
e-mail messages, Weather will show the current temperature, and News will
show regional headlines.
6.

Click All apps towards the bottom left corner of the Start Menu. A list
containing all of the desktop programs and apps installed on your
computer is shown in alphabetical order.

You will get the chance to further explore the Start Menu as you progress
through this guide.
7.

For now, click the Start button again to close the Start Menu.
Alternatively, simply click away from the Start Menu to close it.

© CiA Training Ltd 2016

32

Windows 10

ECDL

Section 2 Getting Started

Driving Lesson 16 - Window Features
Park and Read
Windows are rectangular boxes that appear on the Desktop. They can be
dragged (clicked and moved) to any position and size you like. Inside a window,
you can interact with programs, adjust computer settings, and manage files and
folders. Many windows can be open at the same time and each can perform a
variety of different, simultaneous tasks.

Manoeuvres
1.

Click the File Explorer button on the Taskbar.

2.

A File Explorer window opens. This type of window allows you to
navigate through the storage devices and folders on your computer.
Title
Bar

Ribbon
Address Bar

Search

Navigation
Pane

View
Pane
Folder
Icon

Scroll Bar

Status
Bar

3.

File Explorer starts by showing you a number of popular “Quick access”
folders together with a list of recently opened files. Spend a moment
finding all of the features shown above.

The Title Bar shows the name of the folder or program that appears inside of
the window. The Address Bar displays the location of the folder shown in the
View Pane.
Windows 10
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4.

Notice the Navigation Pane on the left of the window. This can be used
to explore the folder structure of your computer. The contents of the
selected folder will appear in the View Pane.

5.

Locate the Ribbon. This consists of a range of tabs (currently labelled
File, Home, Share and View) which change depending on the type of
folder or device displayed in the View Pane.

6.

Click the Home tab and examine the options that appear on the expanded
Ribbon. Notice that all of the buttons are organised into groups.
Expand the Ribbon

Tabs
Button

Group name

7.

Click the View tab and examine the options. Click View again and the
Ribbon is minimised (but the tab headers remain).

8.

Next, click the File tab and examine the options that appear. Click the File
tab again to close it.

You can “pin” the Ribbon open by clicking the Expand the Ribbon button,
9.

.

Find the Search box to the right of the Address Bar. This feature allows
you to search for files and folders stored on your device.

10. Finally, whenever a window’s contents are too big to view in one go,
scrollbars are used. A vertical scrollbar allows you to move your view of
a window’s contents up and down; a horizontal scrollbar allows for side-toside scrolling.
Scrollbar
Arrow
Vertical Scroll
Button

Horizontal
Scroll Button

Scrollbar
Arrow

Horizontal
Scrollbar

Vertical
Scrollbar

Scrollbar
Arrows

The window’s view can be moved by clicking the scrollbar arrows or by
dragging the scroll button.
You will learn more about all of the features described in this lesson later.
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Driving Lesson 17 - Closing Windows
Park and Read
The Close button, , found towards the top right of every window, closes that
window. Any processes running within it are also stopped. For example, closing
a program will stop it from performing any more actions.

Manoeuvres
1.

Click the Close button,
window.

, in the top right corner of the File Explorer

2.

The window is closed. Notice that the File Explorer button is no longer
active on the Taskbar.

3.

Start File Explorer again.

Windows can also be closed by right clicking their buttons on the Taskbar and
selecting Close window.
The keyboard shortcut <Alt F4> will also close the currently active window.
Clicking Close on the File menu will close a window.
4.

Using any of the three methods described above, close the File Explorer
window again.
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Driving Lesson 18 - Working with Windows
Park and Read
A window can be maximised (filling the whole screen), minimised (appearing
only as an active icon on the Taskbar), or restored (to any size in-between). If
a window is not maximised, the size and position of it can be changed.

Manoeuvres
1.

Click the Start button to display the Start Menu. Notice that a button for
File Explorer appears here too.

2.

Click the arrow to the right of the File Explorer button. A list of popular
folders appears (called a “jump list”). Select Documents.

3.

File Explorer opens showing the contents of a folder called Documents.
You will learn more about the different folders on your computer later.

The Title Bar and Address Bar now show the name of the selected folder.
4.

Notice the three Window Control Buttons at the top right of the
Documents window: , Maximise, , and Close, .
Window control
buttons

5.

The Maximise button increases the size of a window to the maximum size
available. If the Documents window is not maximised already, click the
Maximise button now.

If the window is maximised, the Maximise button is replaced by the Restore
Down button, . This restores the window to its last (non-maximised) size.
6.

The Documents window now fills the screen. Click the Restore Down
button, , to reduce the size of the window.

7.

The Minimise button hides a window completely, leaving only its active
button on the Taskbar. Now click the Minimise button, .
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Driving Lesson 18 - Continued
8.

When a window is minimised, the program or task inside the window
continues to run. The Documents window can be restored by clicking the
File Explorer button on the Taskbar. Do that now.

9.

Next, let’s try moving a window. Move the mouse pointer over the Title
Bar of the Documents window. Click and drag the window to a new
location in the middle of the screen.

10. The size of the window can also be changed manually. Move the
mouse pointer over the right edge of the window until the pointer
changes to a double headed arrow.
11. Click and drag to increase or decrease the width of the window. This
technique can be used to increase or decrease the size of the window in
all four directions.
12. The size of a window can also be changed in two directions
at once. Place the mouse pointer over a corner so that it
changes to a two headed diagonal arrow.
13. Click and drag to increase or decrease the size of the window.
More than one File Explorer window can be open at a time.
14. Display the Start Menu, click the arrow to the right of File Explorer and
select Pictures from the jump list that appears. A second File Explorer
window opens showing the contents of a folder called Pictures.
15. Drag the Pictures window so that it appears on top of the Documents
window (if it is not already).

16. Notice that the Taskbar has automatically “grouped” the two File
Explorer buttons.

17. Click the grouped File Explorer button and a pop-up appears allowing
you to select which window you would like to activate.
18. Select Documents to activate that window and bring it to the front. Click
anywhere on the Pictures window behind to bring it to the top again.
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